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Components That Make Up Your Computer 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

A computer is composed of hardware, not to be confused with software, which is 

installed on the hardware. The basic computer parts are the motherboard, processor, 

RAM, hard drive, video adapter and power supply. You have to have all these parts to 

build a basic computer. 

 

The system unit is the core of a computer system. Usually it's a rectangular box placed on 

or underneath your desk. Inside this box are many electronic components that process 

information. The most important of these components is the central processing unit (CPU), 

or microprocessor, which acts as the "brain" of your computer. Another component is 

random access memory (RAM), which temporarily stores information that the CPU uses 

while the computer is on. The information stored in RAM is erased when the computer is 

turned off. 

 

Almost every other part of your computer connects to the system unit using cables. 

The cables plug into specific ports (openings), typically on the back of the system unit. 
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Hardware that is not part of the system unit is sometimes called a peripheral device 

or device. 

 

The motherboard is the most important part of a computer. Every other computer part 

connects to the motherboard. If the motherboard does not work, none of the other parts 

will either. 

 

The cpu or processor is the computer's brain. It is in charge of telling your computer 

what computer processes to do and when to do them. It is mounted onto the motherboard 

along with the RAM. 

 

Random Access Memory, also known as computer memory reads and writes data. RAM 

does not store information but can remember information while your computer is on. 

Once you turn off your computer, any information stored in the RAM is erased. The more 

RAM your computer has, the faster it can run. 

 

A hard drive stores programs, images, and all other files. Unlike RAM, a hard drive 

stores and remembers information. The video adapter allows your display device to 

display a picture from your computer. Video adapters are also referred to as a graphics 

card, video board, video controller, and video card. 

 

A power supply unit supplies power too all of the computer components. Without this 

you would not be able to turn your computer on. 

 

Your computer's not complete without such peripherals that must be attached to it. One 

such peripheral would be the Monitor that displays all data. And you cannot give the 

computer instruction with having a keyboard attached. A Mouse will make this task 

even easier. 

 

In this guide, you'll see detailed photos, audios, and videos of these components, how to 

install, upgrade, and trouble most. 

 

So, Let's Get Started.................... 
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How To Add Random Access Memory To 

Speed Up Your Desktop 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you purchase a computer, it will come with an adequate amount of RAM or 

Random Access Memory to run the operating system and all software that is installed. 

 

However,as you install more software, your PC will begin to slowdown. The amount of 

RAM you need depends on your operating system on all applications you may be 

running on your computer at any one time. 

 

Installing memory is one of the easiest tasks. Take the time to first be sure you have the 

right RAM for your computer. If you're in doubt take it back to the place of purchase 

and be sure you have the right RAM. 
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After being certain you have the right RAM, you're ready to open the system unit and 

begin. But first, you need to remove static electricity. Watch this short video about 

installing RAM Memory on the motherboard. 

 

Remove static electricity before you remove the new memory from its protective wrap. Its 

best to purchase a Wrist Strap if you plan on working in your PC often. But if not, you 

can simply touch a door knob or your computer's metal case to remove the static 

electricity. To install your new Ram, perform the following. 

 

Check to see if you have ample light. You may want to have a container to place small 

screws in. The system unit cover may have small screws and you don't want to lose them. 

 

After you have plenty of work space and ample lighting, prepare your mind as well. Make 

this and every other adventure of working on your computer educational and fun. 

 

Take the time to study the actual components inside your computer. You'll be glad you 

did should something go wrong. Follow these steps to install your drive. 

 
 
 

First: Turn off your computer and unplug all peripherals. Take notice of how you 

unplug or disconnect any devices. Locate the RAM on the motherboard. 

 

Second: Remove the side panel of the tower system or the cover if you have a 

desktop. Place the panel in a safe place well out of the way. 

 

Third: Before touching anything inside the system unit, remove electrical static 

charge from your body by touching a door knob or any unpainted metal surface. 

 

Fourth: Remove the new memory from its protective wrapping and locate the 

sockets or memory banks to install the new memory chips. 

 

Fifth: Notice the type of retaining clips that hold the chips in place. Remove any 

old chips you intend to move. 
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Now to be sure you won't damage the chips, ground yourself again to remove 

any remaining static electricity. 

 

Sixth: Pull the retaining clip open and carefully slide the RAM Chips in their 

memory banks. Push the clips back over the new memory chips. 

 

Seventh: Check and double check the firmness of the chips by gently trying to move 

the from side to side. Take a good long look at the chips for anything that looks unusual. 

 

Eighth: Replace the system unit cover and reconnect all peripherals. Reboot the 

computer and the operating system should recognize your new or added memory 

without any problem. 

 

Its that easy when it comes to installing new or more memory. Read your 

computer's manual first to find out what type of ram memory you have and what is 

needed for upgrades. 

 

Take time to Visit the Kingston Memory site above and use their memory configurator 

to find out the memory you need to upgrade your computer. 

 

And go ahead and enjoy the faster speed you should experience once your new memory is 

installed. Don't forget to run scandisk, defragment,and disk cleanup to clean your hard 

drive of extra space. 
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Install More RAM In Your Laptop For More 
 

Speed 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Your Laptop is indeed your companion, especially when you're on the go. We often 

take both our laptops on vacation, in town to catch up on some work. And boosting 

your knowledge of your laptop with go a long long way in saving you money by 

repairing it yourself. 

 

Installing memory is one of the easiest tasks. Take the time to first be sure you have the 

right RAM for your computer. If you're in doubt take it back to the place of purchase and 

be sure you have the right RAM. After being certain you have the right RAM, you're 

ready to open the system unit and begin. But first, you need to remove static electricity. 

 

First: Turn Off the Laptop and remove the Battery, normally located on the bottom 

of the computer. 
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Second: Turn the Laptop over and locate the RAM compartment. Some Laptops 

Memory Module Compartments may be located in another area. Check your 

owner's manual to be certain. 

 

Third: Remove any and all ESD or Electrical Static Charge from your body and 

clothes so no damage to the chips can occur. Use a screwdriver to remove the RAM 

compartment cover. 

 

Fourth: Study the Memory Modules for a minute to understand how they are 

installed so you won't forget how to add the upgraded modules. Grasp the clip holding 

the old Module in place and push it up. 

 

Grasp the module and carefully lift it up and out of the socket. Notice the indent in 

the module. This allow the module to be installed in only one way. 

 
 
 

Fifth: Remove the new RAM from its protective wrap and study it to be sure it is not 

damaged. Place the module in the empty socket, carefully press down and allow the 

clips to click in place. 

 

Sixth: Replace the Memory cover, and Battery. Reboot the computer and the 

operating system should recognize your new or added memory without any problem. 

 

Its that easy when it comes to installing new or more memory. Read your 

computer's manual first to find out what type of ram memory you have and what is 

needed for upgrades. 

 

Take time to Visit the Kingston Memory site above and use their memory 

configurator to find out the memory you need to upgrade your computer. 

 

And go ahead and enjoy the faster speed you should experience once your new memory is 

installed. Don't forget to run scandisk, defragment,and disk cleanup to clean your hard 

drive of extra space. 
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How to Easily and Safely Install RAM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

KNOW THE TYPES OF RAM MEMORY HERE 
 

 

Check to see if you have ample light. You may want to have a container to place small 

screws in. The system unit cover may have small screws and you don't want to lose them. 

 

After you have plenty of work space and ample lighting, prepare your mind as well. Make 

this and every other adventure of working on your computer educational and fun. 

 

Now go over to www.ultimatepcrepair.com/photos.html to familiarize yourself with all 

components inside the PC. Take the time to study the actual components inside your 

computer. You'll be glad you did should something go wrong. Follow these steps to 

install your drive. 

 

Turn off your computer and unplug all peripherals. Take notice of how you unplug 

or disconnect any devices. 
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Remove the side panel of the tower system or the cover if you have a desktop. Place 

the panel in a safe place well out of the way. 

 

Before touching anything inside the system unit, remove electrical static charge from 

your body by touching a door knob or any unpainted metal surface. 

 

Remove the new memory from its protective wrapping and locate the sockets to install 

the new memory chips. 

 

Notice the type of retaining clips that hold the chips in place. Remove any old chips you 

intend to move. Now to be sure you won't damage the chips, ground yourself again to 

remove any remaining static electricity. 

 
 
 
 
 
 
 
 
 
 
 
 

 

WANT TO SPEED UP YOUR PC? TRY ADDING RAM 
 

 

Pull the retaining clip open and carefully slide the RAM Chips in their memory 

banks. Push the clips back over the new memory chips. 

 

Check and double check the firmness of the chips by gently trying to move them from 

side to side. Take a good long look at the chips for anything that looks unusual. 

 

Replace the system unit cover and reconnect all peripherals. Reboot the computer and 

the operating system should recognize your new or added memory without any problem. 

 

Its that easy when it comes to installing new or more memory. 
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Read your computer's manual first to find out what type of ram memory you have 

and what is needed for upgrades. 

 

Visit the Kingston memory site above and use their memory configurator to find out 

the memory you need to upgrade your computer. 

 

And go ahead and enjoy the faster speed you should experience once your new memory is 

installed. Don't forget to run scandisk, defragment, and disk cleanup to clean your hard 

drive of extra space. 

 
 
 

 

How To Troubleshoot RAM Memory 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

When you have memory problems, you know you are limited in your troubleshooting 

and hopefully you will be able to resolve the problem quickly. Its a great idea to first 

verify the problem exist. 

 

Shutdown and reboot your computer to see if the problem re-appears. Sometimes 

rebooting the PC will correct the problem and you'll be on your way. 
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Memory problems are normally caused by defective memory chips, installing the chips 

wrong,and the memory being configured improperly. So often, the suspected memory 

problem may be due to software, especially if new software was recently installed. 

 

Many seemingly memory problems are sometimes problems coming from other 

components. If you see error messages on the monitor as the system boots up, be sure 

to write the message down for reference later in troubleshooting. 

 

Memory problems can come from brand new computers. When this is the case,you'll 

need to troubleshoot the computer as a whole. In this case, contacting your PC's support 

will be your first line of defense. 

 

If The Computer Fails To Boot: If you installed new ram memory, check to be 

sure the memory modules are completely installed. It may be that they are not fully 

seated in their banks. 

 

Check the same even if your computer is brand new. Installation at the factory often lead 

to computer failure by employees making mistakes when computer assembly is done. 

 
 
 

If Computer boots but the screen is blank: this is another symptom of loose 
 

memory chips. Another cause may be you are installing the wrong type of memory. 
 
 

This problem can also be caused by video display problems. If the monitor brightness 

and contrast are turned down,the blank screen will be the result. And a loose or 

uninstalled video card will produce the same failure. 

 
 

 

If Computer Produce Error Codes: write the code or codes down and look 

up the codes in your user manual or support web site. If you install mismatched memory 

chips,certain error codes will appear. 
 
 
 
 

 

©Copyright 2010 • Author Name • WebSiteLink.com Page 16 

http://techrepublic.com.com/5100-6255-1058486.html


The Ultimate Computer Repair Guide 

 

If PC boots but all memory not recognized: check to see if you installed the 
 

right type of memory. Again, even if the computer is new, verify this by contacting 

your PC support by phone,or email. 

 
 
 

THAT "General-Protection Faults" Error is caused when two or more 
 

software programs are trying to use the same memory address. In most cases, simply 

rebooting the computer will correct this. 

 
 
 

 

Memory Testing Software Utilities 
 

Memory problems are sometimes caused by other components in the system unit. 

Dirty and corroded slots can produce memory bank problems. 

 

There are some good ram memory testing software that you can download when you 

suspect your system is having memory problems. MemMXTest is a utility to test memory 

at http://panic.et.tudelft.nl/~costar/memmxtest where you can download their program. 

 

Gold Memory is a neat stand alone memory testing shareware at 

http://www.goldmemory.cz/index.php and you can use it free for the first 30 days. 

After that you will need to register the software for just $24.00. 

 

Brain Check at www.brain.com/braincheck_sst_1pg.htm is an online memory test 

site where, after you sign up for an account, you can scan your computer's memory in 

the hopes of detecting early ram memory problems. 

 

Open your computer's system unit and locate the ram memory. Do you know what type it 

is. Do you have the user manual readily available should you need to quickly identify 

your memory chips. 
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Be well prepared ahead of time to know where your memory is located in the 

computer, what type they are and the indications that your memory is going bad. Take 

the time to understand your computer's memory now. 
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Get More Computer Storage By Installing A 
 

Larger Hard Drive 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Your Hard Drive is one of those components inside your computer that is mostly likely to 

fail as the system gets older. This is because it is a mechanical device that uses motors, 

and other moving parts that are guaranteed to wear out. 

 

Before you remove the system unit cover to gain access to your hard drive, remember tor 

remove any and all ESD (Electrical Static Discharge) from your body. This is done by 

touching an object such as a doorknob or the case of the system unit. After this safety 

precaution is done, remove the system unit cover and locate the drive. 

 

Depending on the location of old your Hard Drive, you may have to remove other 

components just to have access to it. If so, take very good notes of everything you 

disconnect or remove, you can refer to them later as you replace the components. 
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Look to be sure you have empty drive bays to install extra drives should you decide to 

add a second drive. 

 

Once the drive is clear of other cables and components, carefully remove the power and 

data cable from the drive and remove the drive retaining screws. Some drives are mounted 

on rails, if this is the case,just slide the unit out through the front or top of the system unit 

chassis. 

 

Separate the drive from the rail and now install the new drive to the rail. Watch those 

screws, they are small and can be easily lost. Remember to ground yourself from time 

to time to remove electrical static buildup. Watch this short video to see the Drive 

being installed in the system unit. 

 

When the drive is mounted on the rail, (if you have one) write down any information on 

the front of the drive that may give you the type, model number, sectors, cylinders, 

access time and other information that seem important. You may need it when you 

configure the hard drive. Nearly all new hard drives have software that does this for you. 

 

After being certain that all cables,connections and all other components are in place, 

replace the system unit cover, reconnect all peripherals to the system unit and plug it 

into the wall outlet. 

 

Turn on the computer. Now you will need to tell the computer that it has a new or 

different hard drive. You will have to start your PC with a bootable floppy disk if you 

replaced or installed a new hard drive. 

 

If your new drive came with a owner's manual, keep it handy for future reference and you 

may need it to config your drive. Even though you have installed the drive with its cable, 

the computer doesn't know that you have done this. So we must tell the PC and while we 

are at it, we must make the drive useable by partitioning and formatting it. 
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Your Hard is a delicate device and will wear out soon. Learn about the types of Hard 

Drives, how to remove and install them quickly. Doing so will save you on downtime 

with your computer and you'll earn extra cash by installing new drives for your relatives 

and friends. 
 
 
 

 

Here's How To Replace A DVD Drive In Your Laptop 
 

Replacing a DVD drive in a laptop is very simple. Even if you don't have a lot of technical 

expertise this is something that you can do. There are no screws involved or opening up of the 

computer case. This is because most laptops all use modular drives that pop right out. 

 

A DVD burner is the drive that allows you to write data or video/audio files on a DVD 

disk. The amount of information that can be written to a DVD is typically 4.7 GB. 

However, double-layer DVD burners can write up to 8.5 GB of data on a disk. Devices 

with a LightScribe-enabled optical drive allow you to burn DVD labels as well. 

 

An installation of a new DVD burner on your laptop may be required due to the failure 

of the original hardware or as an upgrade from a CD/DVD-ROM (read only) drive. Get a 

replacement from the manufacturer. 

 

Laptops don't have big open cases that will fit any DVD drive you buy. The cases for the 

drive are somewhat proprietary to the manufacturer of the laptop. Call your manufacturer 

and give them your exact model and serial number to order the right sized DVD drive. 
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Shutdown the laptop and make sure it is completely powered off. Disconnect the plug 

from the battery and set the laptop on a flat dry surface. Turn the laptop over. You may 

have to check your manual but most laptops have a button to push or slide to release the 

drive. Push the drive straight out and remove it from the laptop. Insert the new drive in the 

reverse way you pulled out the old drive. 

 

Insert an edge of a paper clip into the emergency eject hole of the DVD drive to open it. 

Gently pull out the disk tray. Locate two screws (one on some laptop models) on the 

back laptop panel that secure the DVD drive. You may need to consult your laptop 

manual for the information specific to your laptop. 
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Unscrew the screws and carefully pull the DVD drive out of the laptop. Insert the DVD 

burner on the place of the old drive and slide it all the way down. Complete the 

hardware installation by securing the DVD burner with the screws you removed earlier. 

 

Turn the laptop right side up and turn the power on. The DVD drive will basically be 

automatically found and work either fully or with basic functionality. Install any drivers 

by inserting the CD that came with the drive or by downloading them from the website. 

Installing the driver may add advanced functionality that the older drive did not have. 
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Its that easy to remove the old Dvd Drive and replace it with a newer one. Whenever 

possible, get your hands on a laptop and try this yourself. Its both easy and rather fun 

as well. 

 

Power is knowledge and using your knowledge the right way can bring you many 

financial blessings. Don't tamper with a laptop that's under warranty. Grab an older model 

and then Practice...Practice...and Practice some more. 
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Installing A Sound Card The Easy Way 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Sound Card installation is indeed simple and rather straight forward, that is,when you 

know how to do it. Opening the system unit can be a scary task for some of us, 

especially if we have not performed this task before. 

 

The key is to be calm,take your time,and make it fun. Look forward to looking inside the 

computer and see just how many components you can readily identify. Remember to 

touch a doorknob or any grounded metal object to remove static electricity from your 

body. To install your new sound card,let's perform the following. 
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Open The System Unit 
 

Remove the system unit cover and locate an empty expansion bay. Note that the rear 

cover of the slot may have to be removed on most computers. Before touching anything, 

ground yourself to remove any buildup of electrical static charge from yourself. Touching 

the computer case or a doorknob will do the job. 

 

With the cover removed from the system unit,lay the computer on its side. You may 

have to remove other connections or devices to have clear access to the empty card bay. 

Take notes of any devices or connections that you make so that you can refer to them 

during installation of the new card. 

 

New sound cards must be installed in the PCI slot. After removing the small rear cover, 

remove the new card from its protective wrap. This wrap is intended to keep the card 

away from electrical static charge. 

 
 
 

 

Installing The Sound Card 
 

Grasp the card and align it with the PCI slot. Slowly but firmly press the new car 

completely in the PCI slot. Check to be sure no part of the yellow contacts can be see 

when the card is pushed in. 

 

Secure the sound card to the system unit by using the screw that you removed when 

removing the rear cover. Use this screw to secure the card to the case. 

 

If you have on sound installed on the motherboard and you want to install another card, 

most systems will disable the motherboard integrated sound. If not, consult your 

computer manual to find the correct jumpers to disable the motherboard sound. 
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Now the cdrom audio cable must be connected. Insert one end of the audio cable for the 

cdrom or dvd drive into the CD-IN socket of the sound card. The other end is inserted 

into the audio-out socket of the cdrom or dvd drive. 

 

Check and double check all connections before you replace the system unit cover. If 

all connections are good, replace the cover and reboot the system after all peripherals 

are reconnected. 

 
 
 

 

Replace The System Unit Cover 
 

The computer should automatically detect the new card and attempt to install the 

device drivers needed to communicate with the card. Windows should prompt you to 

install the software needed to allow the card to communicate to the computer. 
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The new card should have come with a cdrom with device drivers and other software for 

the card. Simply inserted the cdrom in the cdrom drive and select the cdrom installation 

when prompted. 

 

Test the new sound card by re-booting the computer. You should hear the Windows 

startup sound if the card is operational. In some cases,the new card will be operational 

without rebooting your computer. 

 

Installing or upgrading your sound card is that easy. You will need a quality speaker 

system to take full advantage of your new sound card. Get a speaker system with a super 

woofer for maximum sound quality. 

 

Those new games and your new music cdroms will be much more exciting with that 

new sound bursting from the new sound card. 

 

If you're blessed enough to have two computers,install the card in the other system, at your 

convenience. This will give you the added training of installing computer components. 
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Can You Install A New Sound Card In Laptops? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The sound card is an integrated on-board in laptop. If you want to improve the sound 

quality, or you want to use advanced editing and recording functions, you may have 

to install a new sound card The sound card is an integrated on-board in laptop. 

 

If you want to improve the sound quality, or you want to use advanced editing 

and recording functions, you may have to install a new sound card. 
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There are two different kinds of sound cards available for laptops. Below are 

the instructions for installing each. 

 

Locate the PCMCIA slot on your laptop. On most older laptops, the PCMCIA slot 

is located at the left side of the front of the computer. 

 

A PCMCIA card is a thin, credit-card sized accessory generally used to add features 

to laptops. It’s also periodically used in smaller sized industrial and mobile computing 

applications. 

 

You can install the PCMCIA card while the computer is running if your computer 

supports hot-swapping. The operating system will automatically recognize the new 

hardware and find the software for it. 

 

Press the "PC Card Eject" button. 
 
 

Remove the PC card cover. Retain it so that you’ll have it if you remove the new PC 

card later. 

 

Insert the PC sound card with the upper label facing up. Push it gently into place. 
 
 

Your computer will make a sound to indicate that the card has been recognized. 
 
 

Install the necessary drivers and software from the CD that came with your new sound 

card. And That's it. Try this on your laptop, now, before you have sound card problems. 

 
 
 

 

Installing a USB Sound Card in Your Laptop 
 

The newest laptops ship with no PCMCIA slot, only the ExpressCard slot. Normally, 

there are no sound cards that fit the ExpressCard slot so you’ll need to use a USB sound 

card or system. 
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Follow these steps to install a USB Sound Card...... 
 
 

1. Plug the USB sound card into the appropriate USB plug on your laptop. 
 
 

2. Wait for the computer to recognize the new USB device. 
 
 

3. Insert the sound card manufacturer’s CD if prompted to do so. 
 
 

 

And you're off and running. Use the USB Sound card without the worry of having to 

open any computer. 

 
 
 

 

Quick and Easy Sound Card Problem Solving 
 

When something goes wrong with the sound in our computer,we want it fixed,and fixed 

now. Whether its our favorite game we are playing,or that new multimedia application 

we just installed,we simply must have our sound. 

 

When performing any troubleshooting procedure, always perform the basic procedures 

before you remove that device. Its good to look at your sound card and become familiar 

with its location,the type of slot it is inserted into or if it is motherboard integrated. 

 

Carefully take note of any cable,connections on or near the sound card. Sound Card audio 

loss is no fun when you are so used to multimedia sound blasting out of those super 

woofers. 

 

Follow these procedures as a guideline to correcting sound card woes. Be sure to 

consult the sound card or computer manual for actual repair procedures. 
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First: you check to see if the speakers have power. Don't take this for granted. It 

does happen that the speakers have no power or the volume was turned down. 

 

Second: Check to audio cables that connect the speakers to the computer. Check to be 

sure these cables are secure and that the audio connector at the rear of the system unit is 

inserted into the right connector. These connections are color coded on new cards. 

 

Third: Check the possibility that your speakers may be on the blink. Although 

the speakers very rarely fail,it is a possibility that should not be overlooked. 

 

Fourth: Before replacing the system unit cover, check and double check to see if the 

card is fully inserted into the PCI Slot. Its a possibility the card may have crepted out of 

the slot if it was not properly secured to the case. 

 

Fifth: After replacing the system unit cover, reconnecting all peripherals,and turning 

on the computer, check the Windows system folder to see if there are problems with the 

device drivers which are small software used to allow the sound card to communicate 

to the computer. 

 

After you have performed these procedures and the sound card is not working at all, 

remove the card from the computer and try inserting in another system. As a last 

resort, you maybe able to save the purchase of another card,when there was no need. 
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General Computer Troubleshooting 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Troubleshooting Do's are extremely important to remember since they will save you 

money as you follow these steps to prevent damage and save you grief should you ignore 

any of these which may result in a problem showing up. 

 

Take the time to go over these troubleshooting Do's first and pay close attention 

to removing any and all static buildup from yourself. 

 

Troubleshooting Do's consist of the following procedures. 
 
 

DO make sure your hardware device drivers are up to date with any patches 

downloaded and installed. Take the time to visit your video card, sound card, 

motherboard, and other hardware manufacturer web sites to see if you have the most up 

to date device drivers. 
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DO check that all connections are seated firmly and properly in their sockets. This 

is a must check as these connections do tend to work themselves loose over time and 

cause problems you may blame on software. 

 

If you have been working in your system unit recently and you noticed a fault manifesting 

itself, you want to go back and take a look at all connections you were near. Look to be sure 

your fingers did not press against other connections and causing then to work loose. 

 

DO perform preventive maintenance on your computer and keep it clean regularly. 
 

Its a good idea to open up the system unit and remove all dust that have accumulated 

on the motherboard as well as all other boards. 
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Dirt and dust conducts heat and will cause the computer to run at higher temperatures 

than it normally would. Take a look at the vents in the back of the case and remove dust 

that have accumulated. 

 

The best way to remove dust from all circuit boards in the system unit is by a can of 

compressed air, available at any computer store and now, most retail stores. 

 

DO make absolutely sure you have removed any and all electrical static buildup 

from yourself before working inside your computer and before touching any new 

circuit cards and chips. 

 

Please don't overlook this troubleshoot tip. It would be a tragedy to purchase new memory 

only to short circuit them either before you installed them or you do so the process. 

 

RAM, short for Random Access Memory chips are very vulnerable for this. So to rid 

yourself of Electrical Static Charge you may consider purchasing a Wrist Strap. This tool 

is especially designed for this. If you don't want to go this route, you can simply touch the 

case's mental chassis. 
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Troubleshooting Don'ts are just as important to remember and follow as 

those troubleshooting Do's and they will include the following. 

 

DON'T allow your computer to run hot. Each device you install in the system will 

generate heat. Be sure your system is well ventilated. If you install more than two 

extra devices, you should consider installing an extra cooling fan. 

 

Cooling fans are easy to install and will be well worth the effort. They come will 

instructions that are easy to follow. It may be best to simply keep the extra devices in 

your system down to two or three at the most. 

 

DON'T use a brush when you decide to clean the circuit cards and motherboard 

in your computer. They create static electricity that will render them useless. If you 

don't have a can of compressed air, wait until you can get one. 

 

DON'T download and install files from the Internet without scanning them for viruses 

first. This as particularly true for any applications or files you download from file- 

sharing networks. 
 
 

 

DON'T plug in your mouse, keyboard, or any peripheral while the computer is on. 
 

Switch the computer off before disconnecting or connecting anything from it. 
 
 

About the only device you can connect to, disconnect from your computer while it is 

running are USB devices. USB stands for Universal Serial Bus and now come in the 

new version 2.0. 

 

You may have escape that one time when you turn on your computer and something 

went wrong. But it will happen at one time or another. 

 

Don't add to the problem by failing to Do such tasks as removing static buildup. 
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Learn to troubleshoot your computer with great care and you'll be richly rewarded by 

the fact that you were able to diagnose the problem and were safe in the process. 
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How To Revive A Dead Computer 
 

 

When it comes to PC Repair, PC Training courses both online and off, offer a wide 

range of computer training programs and some of the best computer training software. 

But understanding your computer will help you learn how to bring it back to life or at 

least understand why you can't. 

 

Its not something we like to think about but your computer will fail, if you keep it 

long enough. It may be a simple problem,such as the floppy drive not reading the disk 

to a major system crash. 

 

Because computers are run by operators, User Error is the most common cause of 

computer malfunction. When the user is at the computer,he or she may add or 

delete certain files. Or he/she may remove or exchange certain hardware features. 

 

When we look at user error,we must remember that since we're human,the user error 

may be easy to solve by simply asking the last user if he/she installed any software, re-

configured any software or hardware settings,etc. 

 

A large percentage of computer malfunctions are due to environmental factors such 

as power surges caused by lightning, resulting in over-voltage. 

 

Another cause for failure may be room temperature being too high or low,as well as 

dust, dirt, or sunlight. If you're in business and heavily dependent on your computers, 

such factors as room temperature,sunlight and protection against power surges is of the 

utmost importance and simply cannot be overlooked. 

 

The most common pc problem is when you can't access your PC at all. When you turn 

on the power switch, NOTHING HAPPENS. 

 

Here is a quick checklist of troubleshooting procedures you should follow if you 

encounter this problem .We also have videos you can download from the Internet should 

you need assistance in just how to perform these procedures: 
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Try the Power Switch a second or third time. If nothing happens.. 
 
 

Check the wall outlet for power. If the outlet has power. Check the power cord 

itself from wall to computer. 

 

Check the Power Supply inside the System Unit. 
 
 

Replace the Power Supply rather than trying to repair it. 
 
 

If the system make those click noises,but the screen is blank, check the Monitor. 
 
 

If the monitor proves to be good, check the Video Card, even in a new system. 
 
 

Another big headache you will most likely encounter if you're a regular user of your 

computer system,is the fact that Windows will fail to load or the system's POST will fail 

to run. Download the file below to learn much more about the Power On Self Test. Don't 

forget those preventive maintenance procedures that can be done often to keep your PC 

running at peek performance. 

 

Running such Windows utilities as Scandisk, Disk Defragment, and Disk Cleanup will 

help your computer performing at its best. Using a can of compressed air removes dust 

that could build to the point of causing a short. 

 

If you get the computer to boot but it does not want to read from the hard drive, the 

Master Boot Record on the hard drive may be corrupted or even missing. To verify that 

the master boot record has not been damaged... 
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Boot from the floppy disk that contains the FDISK program and type the command 

"fdisk mbr" to restore the master boot record onto your hard drive. 
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How To Speed Up Any Desktop Or Laptop 
 

Computer 
 

 

When you start using a new computer it's fast and may impresses you as a big change 

from before. On the other hand you may be disappointed at the relatively small increase in 

speed. Even if fast, over time your machine may get bogged down. 

 

After a few months you may wonder if it is worth computing at all, considering how 

long it takes to do anything. 

 

The truth is by default when your computer arrives it has many services and unneeded 

programs that can be turned off or deleted without harm. Also with a machine that has 

slowed over time, many things can be done to improve the speed. In fact, after a treatment 

like here's, you'll be amazed what a tiger was under hood. If you were considering it, you 

may decide to postpone the purchase of a new one. The various procedures and habits 

you can perform and change are as follows: 
 
 
 

 

Make Sure You Have Enough Memory 
 

Choose Start Button → Start Menu → Settings → Control Panel → System 

→ General Tab 

 

Before You Buy Computer Memory Upgrades, you can find out how much you have by 

clicking on the System Icon in the Control Panel. The amount is on the first tab that 

comes up, the General Tab. 

 

With Windows 2000 or XP, you really should have at least 1 GB of memory and 2 GB is 

a more comfortable amount. With Vista be sure to have 2 GB of memory you'll be much 

happier. 
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Be Sure To Clean Up Your Desktop 
 

Windows puts everything on your Desktop into memory, for rapid loading purposes. 
 
 

If you have a lot of big files there, that means trouble. Apparently folders are not loaded. 

Shortcuts apparently are loaded, but it stops there. The applications the shortcuts point 

to are not loaded. Maybe downloaded exe files are though. 

 
 
 

 

Make Sure You Have a Fast Enough CPU Chip 
 

Only Windows XP and Vista, in the System Applet 

again, will show you how fast your processor is. 1 

GHz Processor is really the minimum these days. If 

you have less than this, spare yourself some 

frustration and buy a cheap new computer for $250-

$400 from Dell, HP, Compaq, E-machines, or 

Gateway. You'll be much happier. 
 
 
 

 

Uninstall Those Unneeded Applications To Free Up Memory 
 

One last suggestion of the about.com article that sounds useful, is to uninstall unneeded 

programs. The reason for this is apparently the registry settings made by installed 

programs can eventually slow down your machine. A smaller cleaner registry is therefore 

useful. A registry cleaner might be a good tool to use too after removing the unneeded 

programs. It will be discussed again below. 

 

Do You Know the Types of RAM? It's Here! 
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Get And Keep Your BIOS Fine Tuned 
 

In the BIOS (or "Setup") stop floppy seek, stop memory check (Fast Boot), and put 

the disk on best performance setting instead of silent if you have it. 

 

For a faster boot up enter your Bios, by clicking the Delete, F2, or F12 key or whatever 

flashes on the screen when you turn on the computer. Next choose boot order, and 

remove all entries except the first one which you should set to your hard drive. This will 

stop the most of the time useless seeking of a floppy disk at boot time. 

 

If you need to reinstall Windows or some other operation, you can always go back and 

change this entry to floppy or CD. Also there should be a setting in your BIOS to make 

the boot, quick. 

 
 
 

 

Patch Your Computer To Keep It Updated 
 

Go to Windows update on the top of your start menu and download all the patches for 

your operating system, whether they are optional or critical. 

 

Better yet, go into the Control Panel, choose Automatic Updates, Choose Automatic 

(your screen might look different with a different version of Windows). Make it Every 

Day at a time when you are not using your computer. 

 

Generally if you have cable or DSL, despite the risk of infection, computers should be 

kept on and attached to the Internet. This is to allow antivirus and security patches 

downloading at off-peak hours. 
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Keep Your Antivirus Up to Date and Scan Your Disks 
 

Bring your antivirus program up to date and regularly do a full virus scan of your 

computer. Check your antivirus program as it will tell you when the last full scan was 

done. You may be surprised to see it is not what you thought, but was done months ago. 

 
 

 

If you don't have an up to date antivirus program, and don't want to pay for a new 

one, there are several high quality free ones available to the private consumer. 

 

They are: AVG, Antivr, avast, PC Tools antivirus, Comodo antivirus and the open 

source ClamAV. 

 

Also look into a new different kind of antivirus program ThreatFire which you can use 

to supplement your other antivirus. ThreatFire doesn't look for the fingerprints or DNA 

of known viruses. Instead it looks for suspicious behavior like key logging. 

 

Also try the no longer free WinHki Anti-Virus, which acts as a supplement to normal 

Anti-virus program like above. WinHki calculates the checksums ( a mathematical 

calculation extremely difficult to fool) of your files on initialization. 

 

After that, whenever a virus changes a file it will be flagged by WinHki because 

the checksum will change. 

 
 
 

 

Make Sure Your Antivirus/Internet Security Programs Run at 
 

Night 
 

If you are noticing slowness in your PC and you hear your hard drive churning, it may 

be because the antivirus is doing a scan during the middle of the day. 
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Reschedule it for the night. Also check to make sure it updates at night. While your at it, 

look in Windows update settings in your System app in the Control Panel in XP or by 

itself as an app in the Control panel in Vista. Perhaps it is updating during the day too 

instead of the default 3 AM. That could be a real slower in performance. 
 
 

 

Compare The Best Anti-Virus Programs From Here 
 
 
 
 

 

Make Sure You Have no Spyware 
 

Run at least a couple different antispyware programs. Perhaps most people these days are 

buying full computer suites to use with their computers, which should include antispyware 

programs, but it doesn't hurt to independently run stand alone anti-spyware programs. 

 

The free ones are, SuperAntiSpyware (maybe the best of the free ones now), Spybot, 

LavaSoft's Ad-Aware, Yahoo Toolbar with Anti-Spy, and "Bazooka Adware and 

Spyware Scanner". 

 

Note it's also a good idea to use the free spyware prevention tool, Spyware Blaster. 
 
 

The commercial anti-spyware programs SpySweeper, SpywareDoctor and CA 

Anti-Spyware (formerly Pest Patrol) are excellent. They cost $30-40. 

 
 
 

 

Stop Unneeded Startup Programs 
 

New installation of software often adds unneeded startup entries in any of several different 

hidden locations. These programs will start when Windows starts and take up resources. 

 

The best free program to deal with this problem, is in my opinion, Startup Inspector for 

Windows. 
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If you use this program, be sure to select the "Consult" Button in the upper left of GUI. 
 
 

This will make the program search through its database of startup programs and tell you 

whether the software is necessary or can be safely removed from the bootup sequence. 

Windows Defender is Microsoft's similar program. It's standard in Vista and can be 

reached through the Control Panel. Click on Tools → Software Explorer, to see all the 

programs that begin at startup. 

 

Another good choice is Codestuff Starter. This free program has the additional 

advantage of having a sort of Power Task Manager which will tell you all the programs 

that are currently running and all their dll dependencies. 

 

Additionally there is a new section on Services, so you can look through these semi-

programs that are running in the background and see if there are any you don't need. 

More on services in a later step. 

 

Unfortunately you will manually have to look up your entries in other resources to see 

whether the software is necessary for normal functioning. You can also sometimes get 

info about the manufacturer of the running program by double clicking on its entry in the 

Startup list. The best database for checking whether programs are necessary is 
 

http://www.castlecops.com/StartupList.html. 
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Defragment Your Hard Drive Regularly 
 

Vista now includes an automatic defragment system that is enabled by default. With XP 

or Vista (if you want to set it off outside the schedule) defragment your hard drive by 

choosing Start → Programs → Accessories → System Tools → Disk Defragmenter. 

 

This should be done every week if possible and can take several hour, so again do it at 

night or while you are at work. There are some free disk defragmenter scheduler 

solutions, so you can "set it and forget it." They are startdefrag, autodefrag and Lexun 

Freeware Drivecare. There is also a Microsoft article that tells you how to use Scheduler 

to schedule defragmentation. 
 
 
 
 
 

 

Remove Those Unneeded Files 
 

Hard disk begin to fragment files noticeably and slow down after passing the 50% full 

mark. For this reason, it is said that the single most important investment one can make 

to improve the performance of a PC is to purchase the largest hard drive possible. 

 

This situation will change with the advent of solid state hard drives as the files don't 

fragment meaningfully in these sort of devices. At any rate if you have a hard drive and 

it's over 50% full, use a program like CCleaner or Microsoft's disk utility to get rid of 

unneeded files. 

 

Also uninstalling unneeded software can improve performance for disk space reasons and 

because programs often install right click options which disappear after uninstallation. 

This is valuable because menus are often built on the fly and take time to rebuild each time 

you open them. With less options there's faster performance. 
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Move the Page File to Another Partition 
 

The page file is your virtual memory. Windows uses your hard drive as a secondary 

source of memory in addition to your RAM memory. If you move this file to another 

partition then the one where Windows is installed this can increase performance. 

 

You can change this setting here: Control Panel → System Applet → Advanced 
 

Properties → Performance Settings Button → Advanced Tab → Virtual Memory 

Settings Button → Click on the C drive and change the setting to no virtual memory and 

hit the "set" button → move the selection to another partition and set it to 150% of the 

amount of RAM memory you have in both the minimum and maximum amounts. Then 

click the "set" button. 

 
 
 

 

Stop File Indexing 
 

By default, in order to speed file searches in XP and Vista, Windows indexes the entire 

drive. However most people do not search very often and find that the overhead that the 

process represents in terms of memory and CPU cycle does not justify the short time 

lost looking for files that have not been indexed once in awhile. 

 

It is true that this indexing is only supposed to take place during times when the machine 

is not in use, but the system doesn't work perfectly and makes for continual noise from the 

hard drive through out the time the PC is on. 

 

At any rate to stop indexing is a bit of an involved process. 
 
 

To start it, right click on your C: drive in My Computer or Explorer and choose 

"Properties". Simply uncheck the checkbox "Allow the Indexing Service index this disk 

for fast file searching" → In the next Window that comes up, choose the radio button next 

to "apply changes to C:\, subfolders and files. That's the easy part. 
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Because it's applying the changes to all the folders, this process takes up a lot resources 

and time. As a shortcut to all this you could stop the indexing service in XP by typing 

type "net stop CiSvc" without the quotes. For a long time stop of the Indexing Service 

you would need to disable it. 

 

Type services.msc in the Run box → right click on the Indexing Service → choose 

disabled from the Startup type drop down box. In Vista, do the same thing with the 

command "net stop WSearch" and disabling the Windows Search Service. 

 

A third way to do this in XP and VIsta is to go to Add/Remove Programs in the Control 

Panel (Programs and Features in Vista) and choose Add/Remove Windows Components 

(in Vista "Turn Windows features on and off"). There you'll find the Indexing Service 

which you can uninstall. If I remember correctly with Vista, there is some Indexing that 

goes on even if you have done all three of these things. This might be related to Vista's 

Prefetch and Superfetch systems. 
 
 
 

 

Turn Off Animations 
 

In XP and Vista, some visual effects have been added to the basic Windows 

2000 appearance. These can be removed to improve PC speed. 

 

You can do this here: 
 

Control Panel → System Applet → Advanced System Settings (in Vista) or 

Advanced tab (In XP) → Performance Settings Button → Visual Effects → Adjust 

for best performance. 

 

You may want to restore the use of smooth edges for screen fonts and the showing 

of thumbnails instead of icons (In Vista only). 
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Clean the Registry 
 

Over time the registry gets clogged up with useless registry settings that slow a PC. 

Freeware to fix this issue include PC Fixer, CCleaner and Toni Arts EasyCleaner 

among others. 

 
 
 

 

Stop Unneeded Services 
 

Services are again programs that Windows starts up automatically at startup and run in 

the background (some of them at least others are started when needed). Many of these are 

not needed and stopping them can help speed up you considerably. 

 

To get to services, click on the Start Menu and in the Run dialogue box add 

"services.msc" and hit return. Now, consult one of the lists on the net, which list which 

services are necessary and which are not. 

 

Look at a program called WinServices. If you download the mini setup of version 

2.1.4.0, and choose Tools → "Program Settings" → Columns Tab → Select Activate 

Recommendations → check "Suggested Settings" and "Safely disable", the program 

will show which services you can disable. Use a little common sense here, for instance 

Task Scheduler might be better left on. Check with the other sites. 
 
 
 

 

Turn Off Fancy Desktop Backgrounds, and Screensavers 
 

Elaborate background pictures and fancy screensavers can take up an enormous amount 

of RAM memory and Hard disk space. For instance with hibernation activated, a file 

easily 1 GB in size is created in the root of the C: drive. 
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If you are low on hard disk space, this can be vital. These operations can be done by right 

clicking on a blank part of your Desktop and choosing "Properties." Go to the Desktop Tab 

and set the Background to "None." On the screensaver Tab, set the Screensaver to "None." 

 

To turn off the Hibernation feature in XP only: Right Click on your Desktop → choose 
 

Properties → Click on the Screen Saver Tab → Click on the Power Button in the lower 

right corner → Click on the Hibernate Tab → Uncheck "Enable hibernation". 
 

For Vista see this article in regards to hibernation: http://support.microsoft.com/kb/929658. 
 
 

 

Learn All About ReadyBoost Right Here 
 
 
 
 

 

ReadyBoost for Vista Speeds Boot Times and 

Other Operations 
 

With Vista, if you plug in USB or other flash memory, you will be given a choice to use 

the device with machine as ReadyBoost agent. It's a little complicated and I don't 

understand it, but, the PC uses the drive then for SuperFetch routines as cache memory, 

whatever that means. 

 

All you seem to have to know is that using USB memory as ReadyBoost can speed boot 

times as well as other memory intensive activities that the PC would normally use the hard 

drive virtual memory for. Your free memory can be 256 MB to 4 GB usable by the 

machine. 

 

You must tell the machine to set aside this amount and you will not be able to use that 

memory while the card is plugged in the machine. Apparently also the machine learns 

during each boot up so the boot up times gradually get faster. A Wikipedia article is 

here and at the end of the Live Links/Additional Resources list: 

http://en.wikipedia.org/wiki/ReadyBoost. 
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Note some flash memory is not fast enough to serve as ReadyBoost material. 
 
 
 
 

 

Change Your PC Use Habits 
 

Things that can speed the Windows experience is to rely more heavily on keyboard 

shortcuts. Print out a cheat sheet for yourself for reference. Two links are listed below. 

 

Another thing to do is to use Windows Quick Launch Toolbar. You display this right 

clicking on the Start Button → choosing Properties → Choosing the Toolbars tab 

→ check the Quick Launch Toolbar display option box. 

 

If you hold down the control button you can drag shortcuts from the Start Menu or desktop 

and keep copies in their original locations. Another speed tip is when surfing and 

downloading start many at the same time, you don't have to wait for one download to 

finish before starting another. 

 

Also you might try to download the free Opera Internet browser or Apple's Safari for 

Windows. It is the fastest but will not display some of the pages IE and Firefox can 

display. I use all three browsers about equally. Another thing to try is to set up category 

folders in your Startup menu. 

 

You can then drag the programs folders into the folders. This speed things because it 

takes Windows some time to rebuild its menus each time you click on them. You can get 

to the Start menu folders by right clicking on the Start Button and choosing "Explore". 

 

There is a complication that not all the Start Menus are stored under your user name. 

However if you work at it you can categorize most of your folders by dragging them 

around and placing them in new folders. You can also right click on the folder and 

choose cut, then paste them in your new folders. 
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Additionally if your right click on the Start Menu Folder and it does not give you the 

cut option, it's probably installed in the Default or All user folders. Choose the "Open 

all users" option instead to manipulate those folders. 

 
 
 

 

Have Your PC health Assessed for Free at PC Pitstop 
 

PC Pitstop will give you a wealth of information about whether you have enough disk space, 

how fragmented your drives, whether you have enough memory and many other things 

discussed below. This is an unbelievable free service and can be done anonymously. 

 
 

 

Visit PCPitStop.com By Clicking Here 
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How To Upgrade Your Graphics Card 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

THE PCI-EXPRESS GRAPHICS CARD SLOT ON THE MOTHERBOARD 
 

 

Your graphics card is responsible for sending data to the monitor to display pictures, 

presentations, and videos that you love so much. That being the case,it would be a 

great benefit to you if you get and keep your graphics card up to date. 

 

If your graphics card seems slow you may want to update your current card by visiting 

its support web site and look for any patches or new device drivers. 

 

Take the time to download and install these files and you should see a big leap in the 

performance of your graphics card. As you download the files, don't forget where 

you saved them. 
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Installing The Graphics Card In The System Unit 
 

After choosing the video card that you know is compatible with your monitor,open the 

system unit after the system is turned off, unplugged, and all peripherals are disconnected. 

 

You may want to lay the system unit on its side for easier access to the empty expansion 

bays. Locate the empty AGP Slot to insert the video card and remove the cover plate at 

the rear of the case with a screwdriver. Save the screw to secure the card later. 

 

Before removing the new card from its protective wrap,ground yourself to remove any 

and all electrical static charge from your body. Now you can carefully and firmly inserted 

the card into the Accelerated Graphics Port. 

 

Aligned the card in the port and slowly but firmly pushed the card in the AGP Port. 

You may use a slight rocking back and forth motion to seat the card in the port. 

 

Check to be sure it has been pushed all the way in the slot for a solid connection. Secure 

the card to the case with the screw you saved from the cover plate earlier. 

 

Check and double check your installation process before replacing the cover onto the system 

unit case. With the cover replaced,reconnect peripherals and turn on the computer. 
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AGP Graphics Card 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Check to be sure the Monitor is connected to the correct connector at the rear of the system 

unit. While this may sound rather simple, its possible to make the wrong connection. Look 

for the connector that is color coded with a monitor icon found on the rear of newer 

systems. 

 

The operating system should detect the new video card and install the device driver 

software that will allow the card to talk to the computer. A cdrom should have come 

with the new card with the device drivers and other useful software. 

 

And you should now be able to experience the ultimate in crisp, clear quality graphics 

on your monitor. Its that easy to install and setup your video card. 
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Graphics Card Problem Solving 
 

 

When you have problems with your video display, it can be something as simple as 

having the brightness turned down to a bad controller on the motherboard. If you have not 

done,first learn to identify the components of the video display system. 

 

When you look inside any open computer,see if you can locate the Video Card. Is your 

video card mounted in an adapter slot or is it integrated onto the motherboard. If the card 

is motherboard integrated, locate the jumpers that will allow the card to be disabled should 

you need to install another card. 

 

The Monitor is the second component in the video display and it must be compatible with 

your video card. Be sure the maximum resolution of your video card and monitor are the 

same. Its even better to your a higher resolution display on your monitor. 

 
 
 

 

Nothing on the Monitor 
 

As we first mentioned, check the brightness and contrast buttons on the monitor to be 

sure they are not turned down. Yeah,we know. This sounds a little silly to think this could 

be overlooked,but believe me, it really does. 

 

And while we're talking about simple checks,be sure the monitor is receiving power. If 

the power indicator light is out, remove the power cable and look for any bent or broken 

pins or connectors. 

 

Try to reboot the computer one or two times to be sure the system did not just lock up. If 

nothing happens, replace the cable with a known good cable to prove that the wall outlet or 

surge protector has power. 
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If the monitor has power but nothing is on the screen, check the data cable going into 

the rear of the computer. Be sure the cable is secure. If it is,Turn the power off to the 

system unit, remove the cable and look for broken, loose, or bent pins. 

 

Finally, if you're blessed enough to have two computers, exchange the monitor with a 

good monitor to see if it works. Replace the old monitor if the new monitor works. If the 

new monitor fail as well, remove the system cover to inspect the Video Card. 

 
 
 

 

Monitor Works But No Display 
 

When the Monitor is known to be good but its screen is still blank, the Video Card is 

the most likely culprit. First inspect the card to be sure it is fully seated in its slot if it is 

adapter slot mounted. 

 

Check the jumpers of any motherboard mounted card to be sure a jumper has not been 

lost or loose. If you have been inside your system,its always a possibility to have moved 

the card. 

 
 
 

 

Monitor Works But Poor Display 
 

If your monitor works but the images appear fuzzy, or flickering often, and the text are 

hard to read, it may be time to adjust the video card's resolution and the refresh rate. 

 

Right click the desktop, select properties and open the display properties dialog box. 

Choose the tab for settings and adjust the slider to change your display resolution. 

Most 17-inch monitors will have a resolution of 800 x 600 but choose the best 

resolution for your eyes. 

 

After adjusting the resolution, check the display to see if all flickering and other 

problems have vanished. 
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If not, optimize the refresh rate. The refresh rate is the rate in which the video card 

redraws the screen. Lower refresh rates sometimes cause flickering. 

 

To adjust this rate, open the display properties dialog box in the desktop, and choose 

the settings tab once again. Click the advanced button and choose the adapter tab if you 

still have Windows 98. 

 

If you have Windows XP, choose the Monitor tab. And from there you can set the 

refresh rate to about 70Hz or 70 Hertz. Check your monitor's manual or web site to see 

the maximum refresh rate for your monitor. 

 

To effectively maintain your video display,visit the supporting web sites for updated 

software patches and device drivers. Watch for new control software for your card that 

will greatly boost its performance. 

 

Take the time to clean the system unit case which will allow air to flow freely. This in turn 

will help keep the video components cool which will allow the card the perform smoothly. 
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Easily Installing Your New Hard Drive 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Check your documentation to be sure that the new hard drive you buy is compatible 

with your system. If you don't have the documentation, you can run the system info 

Utility. Here you will be able to see what type of hard drive you have. 

 

Your PC's system setup program will do the same. Write this info down and take it 

with you when you go to purchase your new drive. The hard drive's Access Time is 

another consideration you should check into. 

 

The Access Time is the normal time it takes for the information requested from the disk 

to arrive to the memory of the PC. The larger this time is, the slower the hard drive will be. 

Hard disk drives can be either internal, (inside the system unit) or external, (outside in its 

own case) and they can be removable in some cases. When installing a hard drive, there is 

a slight difference, depending on the type of drive you own. 
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The following steps to installing a hard drive may vary slightly. Be sure to check the 

installation procedures that came with your new drive to check for any differences in 

installation. If you purchased or was given a hard drive from a friend and don't have any 

paper work for the drive, the following steps should suffice in installing and 

configuring your new drive. 

 

To install the original drive or to install a new hard drive, following these steps and take 

extra care in getting rid of any static electrical buildup that your body may have 

accumulated. Take your time. It would be to your advantage to invest in a PC Repair 

Tool Kit if you plan on working inside computers as a hobby or to earn extra income. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Before you remove the system unit cover to gain access to your hard drive, remember 

to remove any and all ESD (Electrical Static Discharge) from your body. This is done by 

touching an object such as a doorknob or the case of the system unit. After this safety 

precaution is done, remove the system unit cover and locate the drive. 
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Depending on the location of old your Hard Drive, you may have to remove other 

components just to have access to it. If so, take very good notes of everything you 

disconnect or remove, you can refer to them later as you replace the components. Look 

to be sure you have empty drive bays to install extra drives should you decide to add a 

second drive. 

 

Once the drive is clear of other cables and components, carefully remove the power and 

data cable from the drive and remove the drive retaining screws. Some drives are 

mounted on rails, if this is the case,just slide the unit out through the front or top of the 

system unit chassis. 

 

Separate the drive from the rail and now install the new drive to the rail. Watch those 

screws, they are small and can be easily lost. Remember to ground yourself from time 

to time to remove electrical static buildup. 

 

When the drive is mounted on the rail, (if you have one) write down any 
information on the front of the drive that may give you the type, model number, 

sectors, cylinders, access time and other information that seem important. You may 
 

need it when you configure the hard drive. Nearly all new hard drives have software 

that does this for you. 
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Now connect the power supply cable to the power connect and the ribbon cable to the 
drive's controller, SCSI adapter, or to the motherboard. IDE drive's have their controllers 

mounted on the drive, so the ribbon cable is hooked from the controller to the motherboard 
 

or Expansion Slot. 
 
 

If you are installing a SCSI drive, you need to terminate the chain by connecting the 

terminator at the end of the daisy chain, or by switching the DIP switches on the 

drive's board. 

 

When installing an external drive,you need to install the SCSI adapter into an empty 

expansion slot on the motherboard. Be sure to use the card's DIP switches or jumpers 

to give the card a SCSI address. Check the drive's manual or documentation for this 

information. 

 

After being certain that all cables, connections and all other components are in place, 

replace the system unit cover, reconnect all peripherals to the system unit and plug it 

into the wall outlet. 

 

Turn on the computer. Now you will need to tell the computer that it has a new or 

different hard drive. You will have to start your PC with a bootable floppy disk if you 

replaced or installed a new hard drive. 

 

The new SATA Hard Drives now come formatted and if not, you can simply use your 

Operating System CD to format the drive and go right into installing the Operating 

System. The Boot Floppy can still be used on older Computers. 

 

Remember, if you're working on an old computer and don't have a bootable floppy, you 
 

may have to find a computer with a floppy drive and perform the following..... 
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Create a bootable floppy disk by formatting a blank diskette with the command of 

FORMAT A:/S. Then edit the Autoexec.Bat and Config. Sys files and change all files 

where you see something like C:\DOS\ANSI.SYS to A:\DOS\ANSI.SYS and change 

only the C: after the = sign. After editing all files, save all changes and copy both the 

Autoexec.bat and Config.Sys files to the diskette. 

 

It would be good to copy some of the helpful Dos utilities such as Scandisk.exe and 

FDISK. exe to your bootable diskette. Once you have started your computer with the 

bootable diskette, enter the setup by pressing CRTL-ALT-S, CRTL-ALT-INS, or 

whatever combination of keys will access of your computer's setup program. 

 

Then enter the new drive's type, cylinder and any other very information it needs to 

complete the setup. Then be sure to save the new information in the setup. There are 

many older computers out there that you'll need the boot floppy. 

 

If your new drive came with a owner's manual, keep it handy for future reference and you 

may need it to config your drive. Even though you have installed the drive with its cable, 

the computer doesn't know that you have done this. So we must tell the PC and while we 

are at it, we must make the drive useable by partitioning and formatting it. 

 

If your new drive is an old IDE or the new SATAhard drive, device drivers are normally 

not needed, and you may have to use the CMOS Setup to tell the computer that the drive 

is there. For the SCSI drive, the disk controller takes care of talking with the computer. 
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Repairing The Hard Drive, Hardware And 
 

Software 
 

 

Since computer users are human, the user can be the primary cause of computer failure. 

And we operators of our computers are in most cases but that, we operate the computer 

but know very little concerning software and hardware components and peripherals. 

 

Since this is the case, you should ASSUME NOTHING when diagnosing any computer 

problem. We diagnosed a new PC with a video display problem. After briefly looking at 

the video card it took a while to see that the video card was not pushed into the adapter 

slot completely. 

 

Even though I looked at the card, I failed to check it thoroughly. This cause me to spend 

more time on troubleshooting that was not needed. The thought of a hard drive failure 

strikes terror in the heart of every computer user. This is because a hard drive failure 

may lead to invaluable data loss. Here are the most common procedures you should 

perform when you experience hard drive failure. 
 
 
 

 

General Hard Drive Troubleshooting 
 

The hard drive can display problems such as "retry, abort, ignore" or "cannot read 

sectors" while operating. This is an indication that there may be bad or unreadable spots 

on the drive. 

 

Reformatting and reinstalling the operating system can normally correct this problem. 

This will cause you to loose all data on your drive so it is important to always have a good 

backup of your files daily. 

 

If the hard drive seems to be causing you problems, such as constant error 
 

messages. Watch this video and, watch this video for a possible cause if your hard drive 
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is showing errors and is slow. 
 
 

There are good good utilities you can purchase that can repair hard drive problems without 

destroying data. The utility Spinrite is a good utility and only cost $100.00 which is a 

good price if you want to avoid the hassle of reformatting the drive and restoring the 

operating system. Here are some general hard drive problems you should start from and 

we'll be more specific later. 
 
 
 

 

Use Operating System Utilities 
 

First you may be able to correct those bad spots and errors from your hard drive by 

performing those PC maintenance in the operating system. Windows has Disk 

Defragment and you should run disk defragment after running Scandisk since scandisk 

will need to fix any problems it finds. After scanning the drive and defraging the files, 

run Disk Cleanup to ensure all junk files have been delete. 
 
 
 

 

Check Drive Cables and Connections 
 

If there is on indication that the drive is receiving power (you don't hear that familiar 

clicking noise or the drive light is no working) check the 4 wire connector coming from 

the power supply. Watch this video to understand and see the cables and some problems 

that the connectors can cause. 

 

If the connection is secure, you can remove the power supply connector and do two 

things. You can check to see if there is voltage with a multimeter. But its much faster to 

connect another 4 wire connector to the drive to see if the drive works. 

 

There are normally extra connectors from the power supply or you can use the connection 

to the cdrom drive to test for voltage from the power supply. 
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If the connection indicates no or very little voltage (4 volts or less) from the power supply, 

the power supply may be going bad. Now check and double check all connections, 

especially if you are someone else have recently worked inside the computer. 

 
 
 

 

If the Drive Will Not Boot Up? 
 

Boot the computer with your bootable DOS disk. If you don't have one made, STOP 

and make one NOW by clicking on Start, Settings, Control Panel, Add and Remove 

Programs and Startup Disk. 

 

Try to access drive C: by typing DIR C: and press Enter. If you see the directories on 

drive C: try to make the drive bootable by typing sys a: c: and press Enter. The system 

files should be restored and the drive may be restored to boot on its own. 

 

If this fails, you may have to reformat and partition the drive with the setup utility that 

came with your drive or computer. 

 
 
 

 

If the Drive Boots but Hangs Up at Boot? 
 

Turn the computer off, open the system unit and disconnect the ribbon cable at the 

motherboard end. Turn on the PC AND You will get an error message that the drive is 

bad and in most cases will go into your BIOS. 

 

Change the hard drive type to AUTO and shut off the computer. Reconnect the ribbon 

cable and see if the hard works properly. The drive settings should be restored and 

should operate fine. 

 

A hard drive that fails to boot up may also have a bad controller. If the controller is 
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mounted on the hard drive, there is not much you can do except replace the drive. 
 
 

In our next issue we will cover problems with the CMOS Settings, the IRQ Settings, 

using Fdisk, the cmos Battery, and more. 
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Hard Drive Software Troubleshooting 
 
 

 

Hard Drive Software Problems and Solutions 
 

If the drive CMOS settings are not correct, the drive will not boot up. Find the key 

combinations to access your BIOS and check the settings to see if the drive has been 

recognized. Select "Auto" from the main BIOS screen and after rebooting, the drive should 

be detected automatically. Be sure to save the changes and then reboot the computer to see 

if the drive works. 
 
 
 

 

Computer Boots but with Many Errors or Hangs 
 

The LBA or Logid Block Addressing settings may be set wrong when your computer 

have many errors, and if your computer is an older model. LBA is a method used by older 

PCs to support IDE hard disks larger than 504 megabytes. 

 

Access your BIOS and check the LBA settings. If the LBA settings are not enabled, 

enter the BIOS and enable your LBA. 

 
 
 

 

Your Hard Drive may have an IRQ Conflict 
 

The primary hard drive controller normally uses the IRQ or Interrupt Request Line of 

number 14 and if you have a second drive, it may use number 15.You may install a 

new device such as a modem that uses IRQ 14 by default and once installed, the may 

not recognize the hard drive. 

 

The solution here would be to change the IRQ setting of the new device you installed to 

another IRQ. Check the manual that came with the new device for possible IRQ settings. 
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Your Hard Drive Device Drives Causing Problems 
 

In Windows XP, Vista, and 7, you can view the device drivers in the Control Panel and 

update them if needed. If you are not sure you have the latest device drivers, perform 

these steps to update, especially if you operating system is Windows 7. 

 

Click on Start, Control Panel, System, and the System Properties will appear. Then click 

on Hardware, and Device Manager. Click on Disk Drives and then your Hard Drive. Click 

on Driver and here you can Update the Device Driver. You also have the option of Rolling 

back to the old driver should something go wrong. 
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What To Do When Windows Won't Boot 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

When Windows fails to boot it is normally caused by you installing a program or device and 

it has caused a conflict with one or more other programs. This will no doubt give you plenty 

of heartache if you're not certain which program caused Windows to not boot up. 

 

If you recently installed a program or application and know where it was installed,you may 

be in much better shape as for as correcting the error. Here are common ways to correct 

the problem of your computer not completely booting up or not booting up at all. 

 

If your computer will not boot-up at all,hopefully you have made a good emergency boot 

disk. You can always make a windows startup disk by creating one from another 

computer running Windows 98 or Me. Perform the following if your computer........ 
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Won't Boot-Up At All 
 

FIRST: Put your boot floppy disk in the floppy drive and turn on the PC. On some 

computers, you may have to access the bios and select the Boot priority to your A: drive. 

Save any changes and select "Start Computer without CDROM support" and press 

Enter. Once you are at the A> prompt,type dir c: and press enter. 

 

If your programs and other files are present,try restoring your system Registry by 

following the steps below. This may repair Windows,the Config.Sys and autoexec.bat files 

to where the PC may boot up normally. When the files are present,its a good indication of 

a good hard drive. 
 
 

 

SECOND: To correct the problem of your computer not booting up,type in "fdisk 

/mbr" and press Enter to restore your master boot record. Type "Scandisk C:" to check the 

hard drive for errors that have occurred. You can also type "Sys C:" to hopefully restore 

files needed to boot up your computer. 

 

THIRD: If the above procedures fail to repair your computer,you can repeat the first part of 

step one above and select "Start Computer With CDROM Support" re-install Windows. 

 
 
 

 

Making a Windows XP Bootable Floppy, if You Still Have 

a Floppy Drive 
 

Windows XP users should create a boot disk now by placing a formatted blank diskette in 

the A: drive, open Windows Explorer to the C:, select Tools, Folder Options, show 

Hidden files and and folders, then View Tab. 

 

Now you uncheck "Hide Protected Operating System Files (recommended).You will see 

a warning and click Yes and click OK. 
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Copy the files ntldr, ntdetect.com and boot.ini onto the disk. Remove the disk and label 

it the Windows XP Boot Disk. 

 

After making your boot disk,recheck "Hide protected operating system files and folders 

(recommended)" in the Folder Options dialog box. 

 

To use the disk when Windows XP won't boot,place the disk in the drive,and unto re-

booting,the computer, Windows simply bypass the basic boot files on the hard drive 

and continue to boot up. 

 
 
 

 

If The PC Won't Boot Past Windows 
 

FIRST: If your Operating System is Windows Millennium,turn on the computer and 

immediately press and hold down the CTRL key. Once the startup options appear, release 

the CTRL key. Select Safe Mode and press Enter. You are now in Windows limited 

version. If you know what caused your computer not to boot, you can now either change 

or delete that program. 

 

SECOND: Repair your Registry by selecting Start,Run and typing "scanregw/fix" and 

press enter. This will fix any damage done to the Registry. You can also restore your 

registry which replaces your current registry with an earlier copy that was backed up by 

your computer. Click on Start,Run and type "scanregw/restore" and press Enter. 

 

To repair your Windows 98 Registry,hold down the CTRL key as you start the PC and 

select "Command Prompt Only".Type "scanreg/fix" and press Enter and 

"scanreg/restore" to restore a previously saved copy of the Registry. 

 

If you have Windows XP,press F8 after rebooting the PC should Windows freeze while 

booting up. You can select "Last Known Good Configuration" after rebooting to allow the 

computer to boot the last backed up files. And you can choose "Safe Mode" to remove 

any files you know caused the operating system to hang up. 
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Be prepared when your operating fails to boot. It would be a great idea to go over this 

article a few times and print it. Make yourself s notebook and place this and all 

related articles there. 

 

If your computer fails to boot or begins to become unstable,you can refer to these articles 

to make corrections that are needed. Learn these steps from your television set with the 

PC Super Pack. 

 

Be sure to note any changes you make to your Registry and if you're not sure,its best 

to find a friend that's pc savvy first. Above all,be certain you back up your registry 

before making any changes and know how to restore as well. 
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Here's How To Replace A DVD Drive In Your 
 

Laptop 
 

 

Replacing a DVD drive in a laptop is very simple. Even if you don't have a lot of technical 

expertise this is something that you can do. There are no screws involved or opening up of the 

computer case. This is because most laptops all use modular drives that pop right out. 

 

A DVD burner is the drive that allows you to write data or video/audio files on a DVD 

disk. The amount of information that can be written to a DVD is typically 4.7 GB. 

However, double-layer DVD burners can write up to 8.5 GB of data on a disk. Devices 

with a LightScribe-enabled optical drive allow you to burn DVD labels as well. 

 

An installation of a new DVD burner on your laptop may be required due to the failure 

of the original hardware or as an upgrade from a CD/DVD-ROM (read only) drive. Get a 

replacement from the manufacturer. 

 

Laptops don't have big open cases that will fit any DVD drive you buy. The cases for the 

drive are somewhat proprietary to the manufacturer of the laptop. Call your manufacturer 

and give them your exact model and serial number to order the right sized DVD drive. 

 

Shutdown the laptop and make sure it is completely powered off. 
 
 

Disconnect the plug from the battery and set the laptop on a flat dry surface. Turn the laptop 

over. You should remove the battery to prevent any chance of the laptop turning on. 

 

You may have to check your manual but most laptops have a button to push or slide to 

release the drive. Push the drive straight out and remove it from the laptop. Insert the 

new drive in the reverse way you pulled out the old drive. 

 

Insert an edge of a paper clip into the emergency eject hole of the DVD drive to open it. 

Gently pull out the disk tray. Locate two screws (one on some laptop models) on the back 

laptop panel that secure the DVD drive. You may need to consult your laptop manual for 
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the information specific to your laptop. 
 
 

Unscrew the screws and carefully pull the DVD drive out of the laptop. Insert the DVD 

burner on the place of the old drive and slide it all the way down. 

 

Complete the hardware installation by securing the DVD burner with the screws 

you removed earlier. 

 

Turn the laptop right side up and turn the power on. The DVD drive will basically be 

automatically found and work either fully or with basic functionality. Install any drivers 

by inserting the CD that came with the drive or by downloading them from the website. 

Installing the driver may add advanced functionality that the older drive did not have. 

 

And that's it to replacing the DVD Burner in any Laptop. 
 
 

 

Don't Cough Up $300 - $500 To The 

PC Tech To Fix Your Computer 
 

Get Your 12 Cdrom And 6 Dvd Set 

Rushed To Your Door And Fix Your 

Computer Yourself.Your Low 

$65.95 Investment Is Guaranteed 
 

CLICK ME PLEASE TO GET YOUR PC SUPER PACK 

6 " Want To Learn PC And Laptop repair Now" 
 

If You're Sick And Tired Of The Lockups,Bootup 

Failures, Upgrade Problems, Those Slowdowns, 

Drive Failures,Memory Low,Video Problems...? 

Don't Put Up With Potential PC Failure When You 
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Can Start Viewing In Depth, Step By Step, 

Detailed, Powerful Videos On DVDS And CDROMS 

That Teach You PC Repair Starting... Right Now..!!! 
 

Click The Book Cover Above To Learn more 
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How To Repair Cable, DSL, And Dial-Up Modem 
 

Problems 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

When it comes to diagnosing the modem and any other computer problem,always 

start with the most obvious first. Modem problems may be repaired as fast as re-booting 

the computer or can be as complex as resolving hardware conflicts. 
 
 

First remember to check for the most obvious signs of trouble,such as loose connections 

at the rear of the computer for external modems. 

 

Internal modems may have their retaining screw at the expansion slot loose or missing. 

Phone line connections may simply be inserted in the wrong connector. Nearly all internal 

modems are inserted into the PCI or Peripheral Component Interconnect slot in the 

system unit. 
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How To Setup Cable Modem With A Router 
 

Get Additional Help From Here With Setting Up A Cable Modem 

 

A Direct Subscriber Line ( DSL ) Modem 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No Power At the Modem 
 

For Internal Modems, first try inserting the modem in a different PCI Slot. Reboot 

the computer and click on Start, Control Panel, and click the Phone And Modems icon. 

 

Then click on modems, properties, and look for the statement "This Device Is Working 

Properly". You can click on Diagnostics and run a test to see if the modem has power 

as well. 

 

External modems can be checked for power by inspecting the adapter plug to see if it is 

plugged in completely. Look to see if any indicator lights are flashing and be certain you 

are using the adapter for your modem. 
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Be sure the surge protector or wall outlet is providing power by plugging in a lamp or a 

radio. If the radio works,the culprit may be the adapter or the external modem itself. 

 

If you purchased the modem in your town,you may have the chance to return it to the 

store and ask the technician to test it with a known good power adapter. You can been 

replace either the adapter or modem. 

 
 
 

Modem Disconnects Often 
 

If your modem, whether internal or external, is working but disconnects from the Internet 

often, without warning, check to be sure your call waiting option is not enabled. 

 

Another culprit that cause this headache is line noise. This noise and interference can be 

caused by such things as loose wiring. Poor waterproofing, old wiring, worn phone 

jacks are other causes of line noise. Make sure no other equipment is using the same line 

that your modem is on. 

 

Be sure other devices as your fax machine, answering machines or even security alarms 

are not sharing the same line as your modem. 

 

Other PCI devices may be causing conflicts with your modem. Clicking the Control Panel, 

and clicking the modem icon will show the message "This Device Has A Problem" or 

something similar if there is a conflict. 

 

Windows will offer ways to resolve the conflict. Take the time to carefully 

follow instructions to correct any conflicts that may be present. 

 

Loose Data Lines for Internal modems and loose or damaged connectors for External 

modems can cause data lost as well. Visual check and double check these connections. 
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Troubleshooting DSL Modems-Internet Access Needed 
 

Get More Information About Troubleshooting DSL Modems Here 

 

An Older Dial-Up Modem 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Modem is Present But Will Not Work 
 

The external and internal modem must have device drivers installed before they will work. 

Bad or incorrect drivers can cause the modem to disconnect as well as not work at all. 

 

If you noticed that the device driver was either missing or corrupt in the modem 

icon, follow the instructions to update the device driver. If some cases, you may have 

to completely remove the old modem from the Windows Device Manager. 

 

Once it has been removed from Windows, reboot the computer and Windows will detect the 

modem and automatically re-install the the device driver. If your modem came with an 

installation cdrom or diskette,use the software on the disk rather than the one in Windows. 

 

Once you are up and running,the first thing you should do is to visit the modem's 

support web site and search for any software patches or updated drivers to download. 
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Common Broadband Problems 
 

The most common high speed internet problems whether its dsl or cable connections 

are not being able to log on and poor signal. 

 

If the Cable modem often reboots,you should check to see if your signal indicator is 

strong. If the signal seems good,electronic signal from mobile phones and other 

devices nearby may be interfering with the signal. 

 

Stop and look behind the cable or dsl modem to see if the connections have worked 

themselves loose or have come off completely. Be sure the connections have not 

be damaged in any way. 

 

The modem is connected to an Ethernet card which will receive and send signals to the 

computer. Look at the rear of the card and see if the green indicator is on. If not, 

there is a problem with the card installation or the card may be faulty. 

 

If the ehthernet card in the computer become loose, your high speed Internet reception 

will be interrupted. Place a finger on the ethernet card and try to move it. If you can, 

open the system unit case and tighten the card. 

 

If the ethernet card has become loose,it may be a good idea to remove it and inspect the 

yellow contacts to be certain they are not dirty or damaged. Power will not transfer to 

the card should this be the case. 

 

Other causes may be the main wiring to the modem may be faulty. The vacuum cleaner 

or the power tools your son is using in the garage may be causing the problem as well. 

And we cannot omit the idea that the cable or dsl modem themselves may be faulty. 

 

While you're learning about your computer,understand the modem at every level and do 

so now while it is still in good operating order. Print or write down modem and all 

troubleshooting tips. 
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Put these troubleshooting tips in a binder or at least in a safe place so you can refer to 

them should your PC fail to boot. Knowing about your computer takes time and effect but 

you be glad you took the time should your system goes on the blink. 
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Tips On Surviving An Operating System Crash 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Once in a while it happens to every one of us, an Operating System crash of you 

computer. Then you have to reformat your hard drive, reinstall the operating system. You 

cannot prevent the loss of time you suffer while working to get everything in order again. 

 

There are some very easy things you can do right now to make ensure your peace of 

mind for your business. You need to be back up and running as quickly as possible in the 

event of an operating system crash. 

 

When you buy your computer, be sure to ask the dealer for a diskette or CD-ROM with 

the drivers for every hardware component that is not standard in the operating system. 

('Drivers' are those pieces of software that the operating system needs for handling a 

hardware component.) Usually such a diskette or CD-ROM has an "autorun" program 

stored: You just need to insert it in the diskette/CD-ROM drive – and the driver installs it. 
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Document everything including usernames, passwords, merchant account numbers, 

important websites and especially software unlock codes. Anything that is not 

written down on paper is subject to be lost. 

 

Back up your hard drive as necessary for how often you have new updates that you 

cannot afford to lose or rebuild. 

 

Important! If you have to completely reinstall your operating system, the "My Documents" 

folder is usually lost. Make sure you don't forget this folder when you do the back up. 

 
 
 

 

So Just What is a Hard Drive Crash? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

More Important Information On Hard Drive Crashes Here 
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Make sure all of your .exe, zip and software install files are on a disk. This is easily 

done by backing them up or burning them onto a CD. You should already have the 

system restoration and any other store-bought software disks handy. 

 

The actual repair or reinstall of your operating system may simple or it may be 

complicated. If you are well versed in this area, you may be able to restore the system 

yourself. If you're like most of us, you may have to call a computer repair professional. 
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When your p.c. is restored, you will be able to simply reinstall your software and 

documents files from the disks you created. If you have access to a secondary p.c., you 

can install your programs on the backup computer in the interim. 

 

A "daily backup" is extremely important to everyone who is working on any "project" 

that is more extensive than one day. It is important because only with that "security net" 

can you work freely. 
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Here's How You Can Recover From a Hard Drive Crash 
 

Watch This Video Further Explaining The Process 
 

 

In addition to 'daily backup', I prefer to do a 'weekly backup' every weekend. You 

should use one directory on your portable computer for "long-term backup". Particularly 

if you often download a software and don't have any physical representative of it. 

 

Re-arrange the directory structure on your desktop computer , creating one primary root 

directory, with a sub- directory for every application you use to work with. The sub-

directories under the root "Own" are only to take the data files associated with 

Winword, Eudora or any other programs that create output. 

 

Whenever you create or modify a file (whatever the file type), be sure to write/update 

the current date in a comment line near the top. 

 

Finally, let's not forget that, especially in computing there is hardly anything bad that 

wouldn't have any positive side effect. Over time a lot of the "scrap" will assemble on 

your hard drive. Nowadays that's not much of a problem, just some wasted storage space. 

But remember the performance is diminished when the operating system has to struggle 

with a lot of complicated entanglements. 
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Following These Steps To Recover Your Hard Drive 
 

First, turn off the computer. If the computer continues to restart after the Windows logo 

appears without giving a chance to access the desktop and a blue screen flashes for a split 

second, it is most likely a registry problem, virus or hard drive fail. 

 

The impending loss of important documents and files is a sickening feeling, but there is a way to 

recover them before reformatting the computer. For an affordable price, external hard drive 

cases can be bought at any retail outlet specializing in computers. After the case is purchased, 

carefully remove the hard drive from the computer by detaching the connected wires, plug the 

hard drive into the case and it will act as an external USB drive. 

 

Once this is completed, attach it to another computer and hopefully it will show up as another 

drive. If this works, simply drag and drop the important files onto the computer and back them up 

onto a USB stick or DVD disc. If this doesn't work, the hard drive has either failed or it's not 

connected properly. 

 

Now that the files are safe, it is time to reboot the computer. Ideally, when a computer is 

purchased, the user will make a back up disc of the operating system in case of a meltdown. If 

you don’t have the disc, contact the company that makes the computer and perhaps they will 

supply one. 

 

A LAPTOP DRIVE DRIVE BELOW. LEARN ABOUT IT HERE 
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